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OBJECTIVES

Demonstrate the workflow for processing photos and
deriving data products using photogrammetry
Converting TIFF files to JPG for viewing

Sorting Photos

Be able to set up Photoscan

Load Photos
Run Processes to create basic products




PURPOSE

This Presentation is to provide the user with a very basic step by
step

The spatial accuracy of map products will be only as good as the
aircraft GPS provides




CONSIDERATIONS

How were the photos collected?

What were the time intervals?

What altitude above the highest point?
What format if thermal images were collected? (TIFF preferred)
Which camera profile was used to collect? (Flight must use narrowest
camera needed)




CONSJI

DERATIONS USED IN

THIS PRESENTATION

 This presentation uses the Skid Fire as an example
* Flight was 2500” above the highest point in terrain
* Flown with the Silent Falcon and FLIR Duo camera




VIEW PHOTOS

PhOtOS are in the fOlder Organize v Includeinlibrary v Sharewith v Slideshow  New folder

to view and begin o

3# Dropbox

Sortlng' N Ote thls f Older & Becent Places 20190715_074019 20190715;)74021 20190715_074023 20190715_074025 20190715_()17:027

haS 2836 images. Images m}il[’)r:;i;:nents T B SR 272.8b. 274 8b.
are geotagged and data is . . |

20190715_074029 20190715_074031 20190715_074033 20190715_074035 20190715_074037

]_n the EX]._f. Make a Copy 278 8bJPG _278.8b.JPG _278.8b.JPG _380_8b.JPG _382.8b.JPG

1% Computer
& Local Disk (C:)

of this folder to work =

ca Local Disk (E:)

from - RECOVERY (F) R 7o % 7 e
0 (s SeagateBackup PlusDrive  20190715.074039  20190715.074041  20190715.074043  20100715.074045 20190715 074047
388 8b.JPG _388.86.PG 388.8b.JPG _458.8b.PG _458.8.PG

ﬁ_i Network

20190715_074049 _074 20190715_074053 20190715_074055 20190715_074057
_460_8b.JPG _462 8b.JPG _500_8b.JPG _568_8b.JPG _571 8b.JPG




SORTING PHOTOS

P e
Ele Edit View Workflow Model Photo Oho Tools Help

3 X SN D Q A - -o-@- M-

(= Model

§ Untitlec

Agisoft Metashape Prof

Perspective 30°
& Workspace (1 chunks, 2836 cameras)
» Chunk 1 (2836 cameras)

Select all photos in the
folder then drag and [E= S TN

. fﬁd S Ewm NI o
drop into the Photos = B B BN

20190715.091503 | 0190715091505 | | 0190715091507 | 0190715091509 | 20190715 091511
_8b.)

Pane of Metashape. W TRAR TERR THRR [RAR

e I T ESN BN e Y
L by P

4 X
. 8 Ll !
20190715.091513 | 2010715091515 | | 20190715.091517 | | 20190715.091519 | 20190715.091521
W Com 583 8bJPG 583 8bJPG _558.8bJPG _591 8bJPG _660_8bJPG
putes

P = pw Local Disk (C:
= m

Cameras -

CPU: Intel(R) Core(TM) §7-68204Q CPU @ 2.78GHz (13ptop)
Py faaily: 6 model: 94 signature: SO6E3N

| m 7 1 Agisoft Metashape Professional Version: 1.5.1 build 7618 (64 bit)
3 \ \ : Platfora: windows
. Q‘ S 3
U4

e

20190715.091523 | 2010715091525 | | 2010715091527 | 2019071509159 | 20190715 091531 R 31.7 G
_8bJPH

. Seagate Backup Plus Drive

NVIDIA Corporation

662 8bJPG 668 8bJPG QuBdro MSERaM/PCIe/SSE2

_668_8bJPG _T73.8b0PG OPERRl. VeRdor:

OpenGL Renderer

€M Network OpenGL Version: 4.6.@ NVIDIA 389.08
Maximum Texture Siz 16384
Markers - Quad Buffered Stereo: not enabled
ARS_vertex_buffer_object: supported
Total Error

ARB_texture_non_power_of_two: supported
Loading photos. ..
Finished processing in 0.561 sec (exit code 1)

Control points

Check points 20190715 091533
774 8bJPG

ScaleBars  a

Total Error

Control scale ...

Check scale b...



SORTING PHOTOS

In the model pane if the =

Camera is highlighted each
image will appear as a blue
dot. Note a large number of
photos are not in the fire
area, they were taken during
the climb, descent, approach
and departure from the fire.




SORTING PHOTOS

Determine an appropriate
point to cut the lines of
photos. In this example it
will be just outside the fire
area. Photos are named
using date and time stamp.
Scroll in close to the point of
breaking the flight line and
you will see the names.
Select a photo and take note

2019C

20190715_084805_461_8b.IPG

20190715_084803_390_8b.IPG

20190715_034801_389_8b.IPG

35_8b.JPG

of it and the direction of
UAS travel.




NOININCH x5 (OTION

Locate that image in the
folder. In the previous slide
we know that the UAS was
enroute to Home. Also can
confirm by location of image
in folder, its % down.
Highlight from that image to
the bottom and delete. Note
this deleted 821 images.
Repeat for the beginning of

the flight.

> @Jf « FLIR Duo Testing » 190715 Skid Fire » EQ_20190715 » EO

o 4
=] Preview

{ Favorites
Ml Desktop

& Downloads
%2 Dropbox

| Recent Places

s Libraries
=] Documents
‘ Music

&=/ Pictures

B videos

1% Computer
&, Local Disk (C)
s ESP (D)
a Local Disk (E:)
s RECOVERY (F;)

(a Seagate Backup Plus Drive

ﬁ,l Network

Slide show

20190715_084751
_281 8bJPG

X 20N
20190715_084801
_389.8b.JPG

20190715_084811
_468 8b.JPG

20190715_084821
_578_ 8bJPG

-
20190715_084831

A22 2k IDA

Print

New folder

20190715_084753
_283.8bJPG
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20190715_084803
_390_8b.JPG

S A
=

o
20190715_084813
_468_8b.JPG

20190715_084823
_578_8b.JPG
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20190715_084833
A2 2k IDG

20190715_084805
_461 8b.JPG
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20190715_084815
_572_8b.JPG

20190715.084825
613.8bJPG

20190715_084835
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20190715_084757
388 8b.JPG
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20190715_084807

_461 8b.JPG

20190715_084817
_574 8b.JPG
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20190715_084827
680_8bJPG

20190715_084837
752 2h IDG
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20190715_084759
_388.8b.JPG

20190715_084809
468 8b.JPG

20190715_084819
_577_8b.JPG
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20190715_084829
_688_8bJPG
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20190715_084839

TAN 2k IDG




SORTING PHOTOS

We are I10W left Wlth 965 e A <« FLIR Duo Testing » 190715 Skid Fire » EQ_20190715 » EO
from the Ol‘iginal 2836. This Organize v Include in library v : S:ljarewitlrw v Slidef\cw v‘

¢ Favorites
- - Bl Desktop R, N s

can be further refined using poe T Rt |y
. ¥ Drophox 20190715_081534 20190715_081536 20190715_081538 20190715_081540 20190715.081542

2 l“ethOdS. Flrst use the | Recent Places _078.8bJPG _178.8bJPG _180_8bJPG _182.8bJPG _188_8bJPG

ODS to determine the time AN AN

o' Music - i . & <
interval between images for & P Plmsipe  asike | wsake. N espe
Evideos - 3 — \ -

_ L)
$ OROY MR

the flight. In this example Y AN Ame b

&, Local Disk (C:) i & s : B S N
the Capture Interval was asror B o e e
11.92 seconds. We can take e . <, m -
every fifth photo since this e n mmae  Byse
was 2 second triggers. B B =3

W

965 items




NOININCH x5 (OTION

20190715_081534_078_8b.JPG - Windows Photo Viewe!

Second, open the image in
Windows Photo Viewer.
Locate a landmark that is
easily seen. Press the
forward button to the next
image and cycle to watch the
landmark move. Estimate
the Overlap. Close to 66%
(landmark in 3 photos) is
needed to process, in steep
terrain more may be needed.




SORTING PHOTOS

In this example it was

Include in library v Share with v Slide show New folder = v

determined that every 5th e ———
photo would be close to 66% i L B S ; o B
Overlap' N oW there are Only ’ Rec:nt;’laces 201_32;{;638;309 201_?2;?5?%319 201_23;?5}?;29 : 2(?33(;;?;;%4249
1 4 Libraries N 8 " ® i o
194 images left to process. S YRS F

S - J * :
20190715_084459 20190715_084509 20190715_084539

_578_8b.JPG _688_8b.JPG _8b. _980_8b.JPG

k= Pictures

B videos

1% Computer
& Local Disk (C) ! a2 ‘ ‘ f ;
= ESP (D: 20190715_084610 20190715_084620 20190715_084630
s Local Disk (E) _168_8b.JPG _278 8b.JPG _388_8b.JPG _7467_8bJPG
s RECOVERY (F) 4 51
= Seagate Backup Plus Drive d 1

- ‘& LIND ’

€M Network 20190715_084640 20190715_084650 20190715_084700 20190715_084710 20190715_084720

578 8b.JPG 688 8b.JPG 764 8b.JPG 871 8bJPG 984 8bJPG

[y
u“ . % N

i, A ? et |

20190715_084731 20190715_084741 20190715_08475: 20190715_084801

_061_8b.JPG _168 _8b.JPG _281 8b.JPG _389_8b.JPG

194 items




VIEW AND SORTING IR
PHOTOS

TIFF formatted images will appear black, data is present just not
visible

If visible thermal images are needed convert to JPG using Image]
Recommend not processing JPG images, use for viewing only
Same process is used for sorting

IR images use same naming conventions, use the same image
numbers to cut the flight lines as used in the EO photos




VIEW IR PHOTOS

This folder contains
970 TIFF images

To actually view the
TIFF format needs
converted to JPG
Converting loses the
temp data embedded
in the TIFF files

JPG is a compressed
format that is

undesirable for
deriving data

Organize v

{ Favorites
Bl Desktop

& Downloads
%2 Dropbox

1=} Recent Places

~a Libraries
| Documents
A 5
@' Music
k= Pictures

B8 videos

1% Computer
&, Local Disk (C)
ca ESP (D)
—a Local Disk (E:)
s RECOVERY (F)

a Seagate Backup Plus Drive

ei‘i Network

970 items

Include in library ¥

Share with v

20190715_081534
_078.TIFF

20190715_081544
_188.TIFF

20190715_081554
_268.TIFF

20190715_081604
_278.TIFF

Slide show

20190715_081536
_178.TIFF

20190715 _081546
_258.TIFF

20190715_081556
_278.TIFF

20190715_081606
_278.TIFF

New folder

20190715_081538
_180.TIFF

20190715_081548
_258.TIFF

20190715 _081558
_268.TIFF

20190715_081608
_278.TIFF

20190715_081540
_182.TIFF

20190715 _081550
_259.TIFF

20190715_081600
_268.TIFF

20190715_081610
_279.TIFF

20190715_081542
_188.TIFF

20190715 _081552
_263.TIFF

20190715_081602
_210.TIFF

20190715_081612
_281.TIFF
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VIEW IR PHOTOS

Organize folders
Open Image]J from its
folder

Process > Batch >
Convert

Select Input and
Output folders as
shown

Set Output Format to
JPG

IR. - Copy
IR - JPG

File Edit Image Process Analyze Plugins Window Help

B o|c|o] <4 [N Al |o|0]] ofs|#]o]| 2] | |

*Multi-point* or point (right click to switch; double click to confgure

~ Batch Convert
Input... | |G:\FLIR Duo Testing\190715 Skid Fire\IR\R - Copy\

Output... | |G\FLIR Duo Testing\180715 Skid Fire\IRUR - JPG\

Qutputformat. |JPEG ]
Interpolation: |Bilinear

Scale factor: 1A00

Convert

" Read images using Bio-Formats

Convert | Cancel i




VIEW IR PHOTOS

Now thermal images can
be viewed and sorting
determinations can be
made. Once
determinations are made
sort the TIFF files in the

Saine way.

@

-

®-|

o

Organize v

<« FLIR Duo Testing » 190715 Skid Fire » IR » IR-JPG

Include in library ¥

¢ Favorites
Bl Desktop
& Downloads

32 Dropbox

=} Recent Places

~a Libraries

<] Docu

ments

& Music

=/ Pictu

res

B8 videos

1% Computer

8
i Local

Disk (C:)

s ESP (D)

ca Local

Disk (E:)

s RECOVERY (F)

s Seagate Backup Plus Drive

€l Network

970 items

Share with v

20190715_081534
078.pg

20190715_081544
188.jpg

20190715_081554
_268.jpg

20190715_081604

Slide show New folder

20190715_081536
178.jpg

20190715_081546
258jpg

20190715_081556
_218.jpg

20190715_081538
180,jpg

20190715 081548
258.jpg

20190715_081608
_278.jpg

20190715_081540
182jpg

20190715_081550
_259.jpg

20190715_081600
_268,jpg

A

20190715_081610
_219.jpg

20190715_081542

20190715_081552
263jpg

20190715_081602
_210.jpg

20190715_081612
_28l.jpg




METASHAPE FLOW
OVERVIEW

Load Photos

Alignment - Geometry is used with geotags to build a sparse point
cloud

Refine - Improves the spacial accuracy of the model

Gradual Selection - removes points with bad geometry

Build Dense Cloud - Builds a dense point cloud based on remaining

points in the sparse cloud
Build DEM - Needed to generate the Orthophoto

Build Orthos
Export desired products




METASHAPE SETUP

Setup the Workspace and organize the 5 panes as below. This maximizes

efficient workflow. Panes can be tricky to mampulate once placed will be
i Untitied — Agisoft Metashape Professional B o ) |
S aV( odel Photo  Ortho  Tooks  Help

Chunk 1 (0 cameras) Mod el PO ne
Workspace
Pane

ID.

Photos Pane

Console Pane

Reference
Pane

((((((((((((

PPPPP



METASHAPE SETUP

Once setup and arranged the program should appear like this

Untitied — Agisoft Metashape Professional -
Ele Edt View Wordlow Model Photo Ortho Jooks  Help
E F = v D Q o o8- v - ] E.
Model
s P
R il Perspective 30°
% Workspace (1 chunks, 0 cameras)
Chunk 1 (0 cameras)
W
EEE = ERBR % @
Cameras & X(m) Y (m) Z(m) Accuracy (m)  Error (m) Yaw (") Pitch (7) Roll (°) Accu
Total Error
Markers - X(m) ¥ (m) Z(m) Accuracy (m)  Error (m) Projections Error (pix)
Total Error
Control points (1)
Check points
ScaleBars Distance (m) Accuracy (m) Error (m)
Total Ervor
Control scale..
Check scale b..

Ready

Agisoft Metashape Professional Version: 1.5.1 build 7618 (64 bit)
Platforn: Windows

CPU: Intel(R) Core(TH) 17-68204Q CPU @ 2.78GHz (laptop)

CPu family: 6 model: 94 signature: SO6E3N

RAM: 31.7 GB

OpendL Vendor: NVIDIA Corporation

OpenGL Renderer: Quadro MSQ0OM/PCTe/SSE2

OpenGL Version: 4.6.0 NVIDIA 389.08

Quad Buffered Stereo: not enabled
ARS_vertex_buffer_object: supported
ARS_texture_non_power. of_two: supported

|



STARTING THE PROCESS

ft Metashape Professional

4 Untitled'

file Edit View Workflow Model Photo Otho Tools Help

E .‘.“. = ¥ S o = - = = o a D.

Ll
o i ! Perspective 30°
"% Workspace (1 chunks, 194 cameras)
» 5 Chunk 1 (194 cameras)

715_084700_764_8b.0°G

Slhide show Print New folder
715_084650_688_8b.3PG
¢ Favorites K A
B Desktop y > 5, 3 .
elect a otos for s . ' : b
% Dropbox 20190715 084409 2019071508419 | 0190715084429 | 2019071508439 | 20190715 084449
058 8bJPG _168 8bJPG 278 8bJPG 388 8b.PG _468 8bJPG
| Recent Places :
1 0715_084630_467_8b. G
e 1Imodade en dara : % : ‘.
4 Documents p ! !
& Music 20190715 084459 20190715 084509 20190715 084519 20190715 084520 20190715 084539 0715_084620_368! B74R5081534_078_b. G
_578.8bJPG _688 8bJPG 760 8bJPG _873 8bJPG 580 8bJPG
and drop from folaer s nse 5
. . | '
y
; g v I e HHSSeker0 28 Pe
C t =
°"‘F‘: o - ! o A | i 504_278_8b.96 v
Local Disk (C) 20190715_084550 20190715_084600 20190715_084610 20190715_084620 20190715_084630 =
_467.8bJPG 3.6

cu ESP (D) 058 8bJPG _168.8bJPG _278 8bJPG _383 8bJPG
s 715_084600_165_6b.PG

s Local Disk (E) 3 ST ! 7
: s RECOVERY ( (i!
s Seagate Backup Plus Drive

@ Network 20190715_084640 20190715_084650 20190715_084700 20190715 _084710 20190715 _084720
= CTMORK: 578 8bJPG 688 8bJPG 764_8bPG 871 8bJPG 984 8bJPG
= EE . ZERENR == — === = - St

[y
Cameras ~  Longitude Latitude . map: professional Version: 1.5.1 build 7618 (64 bit)

-
Core(TH) 17-6820HQ CPU @ 2.70GHZ (laptop)

VLl 201907... -107.803558 33160587 & model: 94 signature: Se6E3n

’ e 2N
v 201907... -107.804977 33159863 20190715 084731 20190715_084741 20190715 084751 20190715_084801 r: NVIDIA Corporation
 E3. 201907.--107.306694 33159000 _061 8bJPG _168 8bJPG _281.8bJPG _339.8bJPG rer: Quadro MSOM/PCIe/SSE2
4.6.0 NVIDIA 389,68

20190715_081534.078_8bJPG 2019071508154 188 8bJPG

194 ite 16384
p’; i Markers ~ Longitude Latitude - S not enabled
”’ " supported
X ‘ﬁ Lot s _of_two: supported
L R § photos...
- Control points Finished processing in 5.129 sec (exit code 1)
20190715 081554 268 8bJPG  20190715_081604_278 8bJPG Check points n [1]:
- ScaleBars  a Distance(m)  Accuracy(m)  Error (m)
-F ‘ Total Error
™ o
> N Control scale ...
Ui e Lo Check scale b...




STARTING THE PROCESS

ional

J Untitled* — Agisoft M pe Prof

File Edit View Workflow Model Photo Ortho  Tools  Help

- & D Q. b v v o - & -

SELECt all IR photos-for

T Workspace (1 chunks, 388 cameras)

Chunk 1 ( <« FUR Duo Testing » 190715 Skid Fire » IR 20190715-1 » to processiR

the model then drag —

_USS.TIFF _LBS1IFF ZIBAWF
¢ Favorites

and drop from folder BEEeE

| Recent Places

.
20190715_084459 20190715_084509 90715_084519 20190715 084529 20190715 084539
. ub _ST8.TIFF _688.TIFF _T60.TIFF _ST3.TIFF _980.TIFF
i Libraries

*| Documents

Note how the EO and i

20190715_084550 20190715 084610 20190715 084620 20190715 084630

_058.TIFF _278.TIFF _383.TIFF _461.TIFF

IR photos separate into . :

)

. Local Disk (E)

2 columns & rcovaev )
5 s Drive
- (. Seagate Backup Plus Drive | 2010071¢ nasgan T e __— e —
_ST8.TIFF _688.TIFF _T64.TIFF _STLYIFF _984.TIFF
o ;E

“(kvq [l 201907.. -107.803558 33160587
V[ 201907... -107.803558 33160587
o/ [ 201907... -107.804978 33150863

Markers ~ Longitude Latitude .

€ Network
m PRBS

Cameras « Longitude Latitude shape Professional Version: 1.5.1 build 7618 (64
ndows

Core(TH) 17-6820HQ CPU @ 2.70GHz (laptop)

6 model: 94 signature: Se6E3h

20190715_084731 20150715_084741 20190715 084751 20190715_084801 1 NVIDIA Corporation
_061.TIFF _168.TIFF _28LTIFF _389.TIFF n Quadro MSeeem/PCle/SSE2

20190715 081534 OTS.TIFF 20190715 081534 078_8b.JPG
4.6.8 NVIDIA 389.08

not enabled
¢ upported
non_power_of_two: supported

_ Total Error
-l Control points ing 1n 5.129 sec (exit code 1)
20190715 081544 183.TIFF 20190715 081544 188 8bJPG Check points Finished processing in 2,936 sec (exit code 1)
ScaleBars  a Distance (m) Accuracy (m)  Error (m) RO Y
o i Total Error
s Control scale ..

Check scale b...

i



STARTING THE PROCESS

Untitled* — Agisoft Me
File Edt  View Workflow
5 - .

R g

% Workspace (1 chunks, 388 cameras)

Chunk 1 (388 cameras)

v i Cameras (0/388 aligned)
» i EO(0/194 aligned)
» B IR (07194 oligned)

rofessional

Model Photo  Otho Tools Help

A

Model

and Add Group.

Rename group to EO,
repeat for IR then select .

Left click on Chunk

all EO images and drop
in EO Group, repeat for

IR.

EEE =

Cameras ~ Longitude
v [ 201907... -107.803558
[ 201907... -107.803558
/[ 201907... -107.804978

Markers ~ Longitude
Total Error

Control points
Check points

ScoleBars  + Distance (m)

Total Error

el Control scale ...

Check scale b...

ERnEBR %

Latitude
33160587
33160587
33159863

Latitude

Accuracy (m)

Altitude (m)
3468 618896
3468619000
3468.188965

Altitude (m)

Error (m)

Accuracy (m) Error (m) Yaw () Pitch (*)
10.000000

10.000000

10.000000

Accuracy (m)  Error (m) Projections Error (po)

Roll (%)

In [1):

Agisoft Metashape Professional Version: 1.5.1 bulld 7618 (64 bit)
Platforn: Win

CPu: Intel(R) Core(TM) 17-682e4Q CPU @ 2.76GHz (laptop)

CPU family: 6 model: 94 signature: SO6€3h

RAM: 31.7 68

OpenGL. Vendor: WIDIA Corporation

OpenGL Renderer: Quadro nsm/wu:/ssez

© NVIDIA 389

488_vertex_buffer_objec:
ARB_texture_non_power_of_two: supported
Loading photos.

Finished proc
Loading photos
Finished processing in 2.036 sec (exit code 1)

ing in 5.129 sec (exit code 1)




CAMERA CALIBRATION

Click Tools and select Camera Calibration. Make sure the boxes
under Frame match what is shown in the picture below. Note Duo

Pro R is highlighted.

Camera Calibration

.. DuoProR Camera type:

~ 194 images, 40003000 Pixel size (mm):

gy DuoProR(3mm)  Focallength (mm):
194 images, 640x512 pi
Enable rolling shutter compensation

Initial Adjusted Bands GPS/INS Offset

Type: Auto

Frame v

.00195 x .00195

Film camera with fidudial marks




CAMERA CALIBRATION

Make sure the boxes under Frame match what is shown in the picture
below. Note that the other set of images is highlighted (13mm).

P X
. DuoProR Camera type: Frame -
194 images, 4000:3000 Pixel size (mm): .017 x .017
5 DuoProR(13mm)  pkocallength (mm): 13
194 images, 640x512 pi
Enable rolling shutter compensation Film camera with fidudal marks
Initial  Adjuste Bands  GPS/INS Offset

Type: Auto ¥ -




ALIGNMENT

Click Workflow Tab and select

Align Photos. Match settings e

below and click OK. Accuracy: Medium
W Generic preselection

This will take a bit to run. This W/ Reference preselection

example with a Photogrammetry Reset current alignment

laptop took 14 minutes and 38 AT

seconds. Key point limit: 60,000
Tie point limit: 0
Apply masks to:

\/ Adaptive camera model fitting

OK Cancel



AFTER ALIGNMENT

. Untitled® — Agisoft Metashape Professional

File Edit View Workflow Model Photo Ortho Tools Help

N B .vwv v v +) (= so S = & &

X Model

G‘Eh-c )

Perspective 30°
35~ Workspace (1 chunks, 388 cameras)

v Chunk 1 (388 cameras, 616,372 points) [R]
v @ Cameras (388/388 aligned)
> & EO (194/194 aligned)
» & IR (194/194 aligned)
Tie Points (616,372 points)

After Alignment is completed click on Chunk and look at Cameras
to make sure that all are aligned. This will match with all the blue

dots are now little panes in the Model Pane. Note this slide shows
Cameras (388/388 aligned)

616,372 points



AFTER ALIGNMENT

IF a few images do not align run
again with all 3 top boxes
unchecked

¥ General

Accuracy: Medium
W Generic preselection
W/ Reference preselection

¥ Advanced

Key point limit: 60,000
Tie point limit: 0
Apply masks to:

\/ Adaptive camera model fitting

oK Cancel



SAVE AND DUPLICATE

skid.psx* — Agisoft Metashape Professional

file Edit View Workflow Model Photo  Ortho
. . PR

E ok M -
BRksL 00 X

"% Workspace (2 chunks, 776 cameras)
v 3 Chunk1 (388 cameras, 616,372 points) [R]
v B9 Comeras (388/388 sligned)
» B EO (194/194 aligned)
» & IR (194/194 aligned)
*% Tie Points (616,372 points)
Copy of Chunk 1 (388 cameras, 616,372 points) [R]
v B Cameras (388/388 aligned)
» B EO (194/194 aligned)
» I IR (194/194 aligned)
%% TiePoints (616,372 points)

Property Value
Copy of Chunk 1
Cameras 388
Aligned comeras 388

Coordinate system WGS 84 (EPSG:4326)

Rotation angles  Yaw, Pitch, Roll

o=

20190715.081534_078.TIFF 20190715 081534.078 8b.JPG

v

20190715 081544 188.TIFF 20190715 081544_188 8bJPG

v v

Tools

Help

- @ @ G ee . E-&-
Model

Perspective 30°

Save. Then right
click on Chunk and
Duplicate. Set the
Copy to Active.

16,372 poinks
& X

EEE Er0 BEBN %

Cameras  ~ Longitude Latitude Altitude (m) Accuracy (m)  Error (m) Yaw () Pitch (%) Roll (") Ac
VGl 201907... -107.803558 33160587 3468518896 10.000000 653147

V[ 201907... -107.203558 33160587 3468619000 10.000000 5492409

/G 201907... -107.804978 33159863 3468188965 10.000000 22033216

Markers 4 Longitude Latitude Altitude (m) Accuracy (m) Error (m) Projections Error (pix)
Total Error

Control points

Check points

ScaleBars - Distance(m)  Accuracy(m)  Error (m)
Total Error

Control scale

Check scale b...

OpenGL Vendor: NVIDIA Corporation

OpenGL Renderer: Quadro MSeM/PCle/SSE2

OpenGL Version: 4.6.8 NVIDIA 389.08

Maxisum Texture size: 16384

Quad Buffered Stereo: not enabled

ARS_vertex_buffer_object: supported

ARE_texture_non_power_of_two: supported

Loading photos...

Finished processing in @.561 sec (exit code 1)

LoadProject: path = G:/FLIR Duo Testing/198715 skid Fire/class
processing/skid.psx

Loading project...

1oaded project in 1.956 sec

Finished processing in 1.058 sec (exit code 1)

Exportaeport: description = $373, path = 6:/FLIR Duo Testing/
190715 Skid Fire/class processing/1.pdf, title = skid Fire

Generating report...

Estimating resolution...

Analyzing chunk. ..

Finished processing in 3.479 sec (exit code 1)

ouplicateChunk: items = (keypoints)

ouplicating chunk...

Finished processing in 13,896 sec (exit code 1)

In (1):

& X



POINT CLOUD

Photo

B

Ortho

Bk : 00 X
"% Workspace (2 chunks, 776 cameras)
Chunk1 (388 cameras, 616,372 points) [R]
~ B Comeras (388/388 aligned)
» B EO (194/194 aligned)
» B IR (194/194 aligned)
*% Tie Points (616,372 points)
Copy of Chunk 1 (388 cameras, 616,372 points) [R]
v B Cameras (388/388 aligned)
» B EO (194/194 aligned)
» I IR (194/194 aligned)
%% TiePoints (616,372 points)

Property Value
Copy of Chunk 1
Cameras 388

Aligned comeras 388
Coordinate system WGS 84 (EPSG:4326)
Rotation angles  Yaw, Pitch, Roll

o=

20190715.081534_078.TIFF 20190715 081534.078 8b.JPG

v

20190715 081544 183.TIFF 20190715 081544 188 8bJPG

v v

Tools

& X

Help

;'J\ & 2 ::v - - -

The Alignment
created the Sparse
point cloud as
shown to the right.

616,372 points.

CEREBN %

Cameras  ~ Longitude Latitude Altitude (m) Accuracy (m)  Error (m)
V[ 201907... -107.803558 33160587 3468618896 10.000000 6531447
VGl 201907... 107803558 33160587 3468619000 10.000000 5492409
o/ Ed 201907... -107.804978 33159863 3468188965 10.000000 22033216
Markers Longitude Latitude Altitude (m) Accuracy (m) Error (m)
Total Error

Control points

Check points
ScaleBars - Distance(m)  Accuracy(m)  Error (m)
Total Error

Control scale

Check scale b...

Yaw (%)

Projections

Pitch ()

Error (pix)

Roll (%)

Ac

processing/skid.psx

OpenGL Vendor: NVIDIA Corporation

OpenGL Renderer: Quadro MSEBEN/PCTe/SSE2

OpenGL Version: 4.6.8 NVIDIA 389.08

Maxisum Texture size: 16384

Quad Buffered Stereo: not enabled

ARS_vertex_buffer_object: supported
ARS_texture_non_power_of_two: supported

Loading photos...

Finished processing in @.561 sec (exit code 1)

LoadProject: path = G:/FLIR Duo Testing/198715 skid Fire/class

Loading project...
loaded project in 1,056 sec
Finished processing in 1.058 sec (exit code 1)

theport: description = $373, path = G:/FLIR Duo Testing/

1 Expor
190715 Skid Fire/class processing/1.pdf, title = Skid Fire

In (1):

ng report.
Estimating resolution...
Analyzing chunk. ..
Finished processing in 3.479 sec (exit code 1)
ODuplicateChunk: items = (keypoints)
ouplicating chunk...
Finished processing in 13.096 sec (exit code 1)

& X



GRADUAL SELECTION

Click the Model tab and select Gradual Selection. In the dialog box drop down
select Reconstruction Uncertainty. Slide the rule to the right and observe the
points being highlighted. Move slider until the points that need removed are
highlighted.

Perspective 30°

Criterion: Reconstruction uncertainty ¥

Level: 110.816

852.4 0.0

616,372 points, 591 selected



GRADUAL SELECTION

Click OK on Gradual Selection. Then click the X in the menu bar above
model. The hlghhghted points will disappear.

-9 b @ Q obc N P o - =

Model

Perspective 30°

616,372 points, 591 selected



OPTIMIZE

&15, 781 points

Click the Optimize
Star, circled to the
left.

Match the
checkboxes as

shown and Click
OK.

Reference
ETErEnceE

L

EE ExO EEEE
General

\/ = \/ s

J Fi J Fi

v Fit Vv Fit

J Rt Vv Rt

\/ - =

Advanced

+/ Adaptive camera model fitting

Estimate tie point covariance

X



DENSE POINT CLOUD

1+ Workspace (2 chunks, 776 cameras)

v £2 Chunk1 (388 cameras, 616,372 points) [R]
In Workspace Pane v = Cameras (388/388 aligned)

hlghllght the IR » @ EO (194/194 aligned)
Group. » & IR (194/194 aligned)

2 A Tie Points (616,372 points)
nght click and v [ Copy of Chunk 1 (388 cameras, 615,781 points) [R]
Dlsable Cameras v & Cameras (388/388 aligned)

» & EO (194/194 aligned)
» @ IR (194/194 aligned)
Tie Points (615,781 points)

Disabled will
appear as below.

» & IR (194/194 aligned)




ERROR REDUCTION

Select View Error as shown in RED circle and scroll to bottom. View
Total Error row.. IF the box is checked the location values for that image
are true, if not MS ignores those values. Sort by clicking the Error(m)
column. Uncheck boxes for up to % of the photos. Optimize again.
Uncheck more up to % of the checkboxes. Optimize a last time.

il o

=G = FEBE #

Cameras Long. err (m) Lat. err (m) Alt. err (m) Accuracy (m) Error (m) - Yawerr (%) Pitch err (%)
V' [E¥ 20190715_083121_458.TIFF -2.248558 -41.709773 -5.527065 10.000000 42134423

Vv [E¥ 20190715_082930_378.TIFF 0.792569 51.686991 5357104 10.000000 51.969912

v 20190715_082930_378 8b.JPG  0.257289 53.870320 5.922984 10.000000 54.294967

Total Error 5.306845 15.285422 6.454817 17.420430

Note the reduction in Error

Total Error 3.058961 4.820879 71.268425 09.242733



SAVE WORK




SETTING BOUNDING BOX

Click the Resize Region dropdown - and select Resize Region. Click
and hold blue dot to drag and place box on the area that is to be
modeled. In general bring the horizontal boundaries just inside of the
ragged edge, make sure the vertical boundaries are well above and
below the me--!




BUILDING DENSE CLOUD

Click Workflow and select Build Dense Cloud. Use settings
below. This will take some time to process. This example with a
photogrammetry laptop took 6 minutes 22 seconds.




DENSE CLOUD

Click the Dense Cloud button ::: -~

-

to view the Dense Cloud. Note there
is a lot more detail now in the model.




BUILDING THE DEM

Biild DEM
DUt U

Click Workflow and select Build " roecton

Type: ® Geographic Planar Cylindrical

DEM. Use settings shown. nE— o %
Click OK.

Parameters

Source data: Dense doud A
Interpolation: Enabled (default) v
Point dasses: Al Select...

Region

Setup boundaries: -107.2

Resolution (m): 2.02088

Total size (pix): 1379 X 2494

OK Cancel




DEM

Double click on DEM in

Workspace Pane to view.

DEM will open a tab

contained in the Model pane.

When finished click the X of

the Tab labeled Ortho. ——

2.41km

2.04km




SAVE AND COPY

Save.

Duplicate the Copy of Chunk 1 only Duplcate Chunl
bringing over the DEM and rename EO Items to copy
S e
Duplicate again with only the DEM and e
rename IR Chunk.




BUILDING THE ORTHOMOSAIC

Set EO Chunk as Active.
Click Workflow and
select Build Orthomosaic.

Use settings shown. Click
0)¢

¥ Projection

TYDEZ o AR IR
Parameters

Surface: DEM o
Blending mode: Mosaic (default) v

Refine seamlines

® Pixel size (°): 2,70708e-06 X
Metres... 2.27644e-06 Y

Max. dimension (pix):

Region
Setup boundaries: - X
Estimate - Y
Total size (pix): X



Double click on Orthomosaic
in Workspace Pane to view.
You can zoom in/out and
drag around.

Ortho may be exported at
this point if the shape is
appropriate.




REFINING THE ORTHOMOSAIC

Click the Polygon arrow .- and
select Draw Polygon. Click and
draw around the fire with a buffer
outside of the line. Left click the
pointer on the polyline. Select Set
Boundary Type and Outer
Boundary.




REFINING THE ORTHOMOSAIC

Right click the pointer on the
polyline. Select Set Boundary Type
and Outer Boundary. Note the line
will appear as pictured. Export
Shape to import on the IR ortho

Ortho is ready for Export.




IR ORTHOMOSAIC

Set IR Chunk Active and
repeat building an Ortho.
The ortho will be black to the
eye until opened in Arc. The
temperature data is
embedded in each pixel.




IR ORTHOMOSAIC

IF needed Import the shape
from the EO ortho. This
allows exportation of the
desired shape.

Right click > Set Boundary
Type > Outer Boundary




SAVE AND EXPORT

Save and prepare for exports.

Export:
EO Ortho

IR Ortho
Report




METASHAPE REPORT

This generates a report for the entire process of Photoscan. It
will be important to have as Metadata as well as tell you a lot
about your model.

To export. Click File > Export > Generate Report...

Fill the dialog boxes as appropriate and save




EXPORTING ORTHOI\/\OSAIC

Click File > Export > Export Orthomosaic > Export _......
JPG/TIFE/PNG wes 84 @PSc:s4520

Raster
® Pixel size (°): 2,70708e-06
Metres... 2.27644e-06

Match ALL of the settings to the right then click S

Raster transform:

Export and save as TIFF file in next popup. o et -

Region

Setup boundaries:

Reset
Total size (pix): 11006 x 19954
Write KML file / write World file

Write tile scheme

Compression

Image description:

TIFF compression: LzZw
IPEG quality: 90
+/ Write BigTIFF file Write tiled TIFF

Write alpha channel

Generate TIFF overviews

Export... Cancel

4



EXPORTING

Only export if needed, a BAER team
may request

Click File > Export > Export DEM,
Export TIFF/BIL/XYZ

Match ALL of the settings to the right. Click
Export and save as TIFF file in next popup.

DEM

Coordinate System

WGS 84 (EPSG::4326)

Raster
® Pixel size (%): 2.1655%e-05
Metres... 1.82143e-05

Max. dimension (pix):

Split in blocks (pix): 1024 x 1024
Raster transform: None
No-data value: -32767
Region
Setup boundaries:
Reset
Total size (pix): 1378 X 2494
Write KML file o/ Write World file

Write tile scheme

Compression

Image description:
Write BigTIFF file Write tiled TIFF

Generate TIFF overviews

Export... Cancel



FINISHED

This concludes processing of fire imagery
You should be able to do basic processing and
produce simple products

The exports can now be brought into Arc and
developed into usable data




ARC TIPS

Note that
Metashape will
always export a
square or rectangle.




Left click layer and
properties. Under

symbology tab =
check the box for &% e

|V] Green

V| Blue

Display i

7 Display Background Value: (R,
'G, B)

Background Value. ™ "¢

Stretch
Wy, " Type: {Percent Clip Histograms..
P A . % | Apply Gamma Stretch: 1.3786¢ 1.37868 1.3786&

) : : Statisies —0—————————————
O ~ ; [From Each Raster Dataset
I < . e ’ ‘

About symbology Red |Green i Blue




ARC TIPS

Now the new
imagery 1s over
layed on the
Basemap.




REVIEW

Students have seen the workflow for processing photos
Students understand how to sort photos

Students can convert thermal images for viewing
Students can setup Metashape and process images
Students can export products from Metashape




Questions




